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Course Description:  An in-depth look at the Internet using Netscape for information retrieval. Participants will
have a chance to view the different types of information servers available and discuss organizational
differences. Topics covered include WWW terminology, using menus, creating bookmarks, searching the
Internet, and configuring the Netscape browser. Netscape is distributed free-of-charge to the campus
community.

Prerequisites: Working knowledge of the Macintosh operating system and a basic familiarity with the Internet.
A basic knowledge of the UNIX environment is recommended, but not required.

This document has been prepared for you by the W&MF staff so that you can familiarize yourself with the basics of
Netscape Communicator™ (version 4.05) for the Macintosh™. This document is meant to serve as a future reference for
you, covering from the very basic to the fairly detailed.  Not all the information mentioned in this document will be
covered in the Navigating the Internet class.

What is the Internet?
The Internet is a world-wide network of computers which communicate with each other using

the Transfer Control Protocol (TCP) and Internet Protocol (IP). People usually refer to these together
with the acronym ‘TCP/IP.’ TCP/IP can be thought of as a universal language for data transfer. It
allows many different kinds of computers to exchange information smoothly, whether they’re
Macintoshes, UNIX Workstations, Supercomputers, or Windows PCs. For a long time, these computers
could only communicate with their own kind (For example, Macs could communicate only with other
Macs through the Appletalk protocol). Adopting TCP/IP allowed these computers to exchange data with
any other computer they could connect to.

TCP/IP itself has many sub-protocols which vary in their functionality. For example, the File
Transfer Protocol (FTP) is a protocol designed specifically for transferring files. The Post Office
Protocol (POP) is a popular format for exchanging electronic mail. The Hypertext Transfer Protocol
(HTTP) is used to exchange Hypertext Mark-up Language (HTML) files. Different programs are
written to handle each protocol, though many modern programs attempt to handle multiple protocols.

What is the World Wide Web?
The World Wide Web (WWW) is the part of the Internet which uses the HTTP protocol to

transfer HTML documents, or ‘Web Pages.’ Today, ‘the Web’ is the most used part of the Internet,
mainly because of the versatility of HTML. Originally designed to allow academics to write articles
whose citations could be linked to their source articles, HTML now allows authors to include a variety
of multimedia and interactive content. Through the Common Gateway Interface (CGI) protocol, HTML
forms can be created to allow users to submit information to web sites. Web browsers which support
JAVA allow users to run JAVA programs on web sites. Browsers such as Netscape Navigator also allow
users to install additional software components, known as ‘Plug-ins,’ which allow the browser to display
new kinds of content.

Web Browsers
Web Browsers are the programs designed to download and display HTML files. Early browsers

performed this function only, but most browsers today also support the FTP and Gopher protocols.
Many browsers also include components to handle electronic mail and newsgroup-reading, often
becoming an all-in-one interface to the Internet. Because of this, many people have come to use the
terms World Wide Web and Internet interchangeably, which is not entirely accurate.
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Netscape Communicator is a popular web browser available on the Macintosh, Windows, and
UNIX platforms, among others. It is primarily a web broswer, but can handle FTP and Gopher
connections, and has build-in modules for electronic mail, newsgroups, and even a component for
creating web pages. If you only need to use Communicator’s web browser component, Netscape
Navigator, you can run it alone. Running Navigator requires less memory than running Communicator.

Netscape Communicator and Navigator are available free to the public.
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IMPORTANT TERMS
We’ve already used many terms which you may be unfamiliar with. Here we review their meanings and
introduce some other terms you’ll encounter. We’ll elaborate on some of these definitions later in the
tutorial.

Bookmark. A Bookmark entry holds the location of a web page. When you save a bookmark for a
page, an entry is made in your bookmarks file. In the future, you can access the bookmarked page
quickly by looking for it in your list of bookmark entries. Netscape, like many other web browsers,
allow you to access your bookmarks directly through the menu bar.

Client. (also client or local machine) The computer operated by the human user, which sends
commands or information requests to a remote server machine.

Downloading. The process of transferring a file to from another computer to the computer you are
currently using.

Protocols:
CGI. Common Gateway Interface, for sending data to programs running on a web server.
FTP. File Transfer Protocol, for transferring file lists and files between computers.
Gopher. An older protocol used to transfer file lists and files. Designed to be more user-friendly
than FTP. It allowed you to read text files in it while FTP required you use another program.
HTML. Hypertext Markup Language, for writing documents which include multimedia content and
which can link to other documents.
HTTP. Protocol for transferring HTML documents and included content.
Java. A computer language often used to write programs which can be used through web browsers.
NNTP. Network News Transfer Protocol, for sending and posting data to Usenet Newsgroups.
POP. Post Office Protocol, the most popular method of electronic mail retrieval.
TCP/IP. The system of protocols which defines the Internet.

Server. The computer which responds to input from client machines. Though maintained by humans,
they typically run by themselves, sending requested files and data to client machines.

Search Engine. Software which searches collections of files for requested information. The files are
usually not indexed and categorized, as in a web index.

Web Browser. Software designed to retrieve and display HTML documents. Most modern Web
Browsers can also handle data transfers through FTP and Gopher, and even electronic mail and
newsgroup reading.

Web Index. A collection of WWW documents organized by subject. Typically sites with web indices
also run search engines to help users locate documents or subjects which have been indexed on the
server.

Web Site. A server which holds HTML files and other WWW content.

World Wide Web. (also WWW) That portion of the Internet which focuses on the exchange of HTML
files and related content through HTTP.
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Uploading. The process of transferring a file from the user’s machine to another machine.

URL. (Universal Resource Locator) A line of text which specifies a documents location on the Internet.
Her are some sample URLs:

PROTOCOL: URL:
HTTP http://www.berkeley.edu/index.html

FTP ftp://cornucopia.berkeley.edu/

Usenet Newsgroups. Discussion areas on the Internet where users can post and respond to messages.
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GETTING STARTED

Opening Netscape
People typically open Netscape simply by double-clicking on its icon. In the Workstation
& Microcomputer Facilities, you can find Netscape in the following location:

PROGRAMS : Networking : Netscape Communicator 4.05: Netscape Communicator 4.05 §

After starting up, the first thing Netscape will display is the default home page. In the Workstation and
Microcomputer Facilities, this has been set to the main page on UC Berkeley’s web site. This page will
contain useful information about UC Berkeley and allow you to explore UC Berkeley’s on-line
resources.

To go to another web page, you can just type in its URL in the Location field:

However, you should have some idea of what everything on-screen is and does before moving on...
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USING NETSCAPE NAVIGATOR: ITEMS ON SCREEN
By default, Netscape will launch with its web browser (Navigator) component open. (This can be
modified in the settings.)

Menu Bar

You can control most of the Netscape’s functions through the menu bar. (Most are self explanatory,
though the menu items represented by icons may require some explanation...

Bookmarks Menu: All bookmarks are listed here.

Communicator Menu: From here you may switch between Communicator’s components and
windows.

The menu bar will change depending upon which component you are using.

Navigation Toolbar (a.k.a. Button Bar)

The Navigation Toolbar provides easy access to frequently-used commands. Most of these control
movement between web pages.

Goes back to the last web page
viewed. Continue to press this to
move further back through the web
pages viewed.

Loads Netscape’s ‘Guide’ site, which
compiles information of interest to
people in particular regions.

If you have moved back, this will
move you forward by one page until
you are at the more recent page
viewed.

If Navigator did not load a web page’s
images, this button will load them.

This will reload the current web page
from the web server.

Prints the current web page.

Goes to the home page, as specified in
Netscape Navigator’s preferences.

Brings up security information for the
current page, and the current security
settings in Navigator.

Loads Netscape’s search engine page,
where you can connect to popular
search engines.

Halts Navigator if it is downloading a
page. Whatever content that has
already been downloaded will be
displayed.

If you hold the mouse button down while clicking on certain toolbar buttons, a pop up menu will
appear.

By holding down the Back or
Forward buttons, you can skip
backwards or forwards to any
web page you have viewed.

Holding down the Guide
button will show other sites
Netscape has available to assist
you.

Location Field
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As described above, you may type in a URL for a page you are interested in into the location field. For
sites that have names of the form “www.something.com” you can simply type in “something” and
Navigator will fill in the rest for you.

Double clicking on the small icon to the left of the location field will make a bookmark entry for
the current page. If you click on the button and drag it to the Macintosh desktop, Navigator will
create a bookmark file on the desktop for the current page.
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Basic Elements of Web Pages
Web pages can contain a wide variety of content, but most web pages mainly contain text, graphics, and
links. Many pages will use animation and scrolling text as well. Others use more obscure tricks through
Java code.

Links:
Links are the defining feature of web pages. To use a link, simply click ONCE on it. The color and
appearance of links will vary greatly according to the design of the web page’s author. On well-
designed web pages, it will be very obvious what is a link and what is just a plain piece of text or
graphic. Links can be displayed as hypertext, or as graphical ‘buttons.’

Usually, a link will cause the mouse’s pointer arrow to change to a hand pointing upwards.

Hypertext Links: Hypertext links are typically colored differently from
the rest of the text and are underlined.

Graphical Links: There is very little to distinguish a graphical link from a regular
image. Usually, a graphic link will look like a button of some sort, and will contain
text suggesting what information the link leads to.

Forms:
Many web pages also incorporate forms, which can be used to send information to web servers. This is a
very important feature of the web, allowing users to send queries to search engines and submit purchase
information to buy items on-line. The appearance of form elements will generally remain constant
across web pages because they are based on similar elements from your computer’s operating system.

This is a form for AltaVista’s
Advanced search engine. You can see
most of the basic form elements here
such as fill-in text fields, check boxes,
pop-up menus, and buttons.

Frames:
Authors can split up your browser’s window into distinct regions called ‘frames.’ Depending on the
author’s design, links on frames pages will update only one of the frames, or update/replace the entire
page. Frames have become rather uncommon on major web sites because they tend to look ‘cluttered’
and complicate the interface. You can tell a page uses frames if only parts of it scroll while others do
not.

Bottom of the Navigator Window

 or 
This padlock icon will appear locked or unlocked to indicate whether data exchanged
with the current site is encrypted. Most pages aren’t, but most reputable retailers and
financial services will encrypt their pages, causing the icon to appear locked.
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The status of a download will usually be displayed
here. If your pointer is over a link, its URL will usually
show here. Some web pages will use Java to have
scrolling ticker tape-like text here.
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USING NETSCAPE NAVIGATOR: FEATURES

Moving around between pages in Netscape Navigator is rather easy. You can click on links, as described
above, or you can type a page’s URL into the Location bar, also described above. Netscape also gives
you many options for using what you have found on the Internet.

Saving Content From the Internet: Web Pages

You can save the text content of a web page by
using the Save As... command from the File menu.

The standard Macintosh Save dialog should
appear. Before saving you should be sure that you

are saving the page in the right format...

Text will save the plain text from the document, with no formatting information.
You will be able to open the document in Netscape or any text editor or word
processor and view the contents. Occasionally the layout of a page will garble
the appearance of the text.
Source will save the actual HTML source code of the document, allowing you to
preserve the formatting and most of the layout. Though the file saved will be
readable by any text editor or word processor, much of the document will
contain the HTML code, making it hard to read the content. To view the
document properly, you can open the file using Netscape or any other web
browser.

The resulting file will have this icon. It is important to understand that only the
TEXT of web page will be saved in this manner. Images must be saved separately.

Saving Content From the Internet: Images (continued)
To save an image, move the pointer over it. Hold down the mouse button until a pop-up menu appears...
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Saving Content From the Internet: Images (continued)

(The Back and Forward commands correspond to the navigation
commands discussed earlier.)
Open this Image will open the image in the Navigator Window.
Save this Image as... will bring up the save dialog for the image. The

image’s format cannot be changed and will be whatever format it is on
the web page. The image’s file name should reveal what image format
it uses. “.jpg” or “.jpeg” means JPEG format, “.gif” means GIF
format, “.png” means PNG format. You can then open the file in
Netscape or any other graphics program capable of viewing the
format.

Copy this Image will copy the image into memory, allowing you to
paste it in other programs.

Copy this Image Location will copy the image’s URL, allowing you to
paste the URL in other programs.

Load this Image will load the image into the current page if it wasn’t
loaded completely before.

It’s important to understand that saving an image will not save the original page it was located on, nor
its placement on the page’s layout. There is no practical way in Netscape Communicator to save a web
page ‘whole,’ in one simple document that will display all text, layout, and images exactly like the
original. Other programs do exist to ‘suck’ a web page off of a site, complete with layout, formatting,
and images intact.

Bookmarks
Another way of keeping a web page available to you is to save its location so that you can return to it
quickly. There are several ways to save bookmarks in Netscape. One of them was described earlier in
the “Using Netscape Navigator: Items On Screen” section. However, the most common way to add
bookmarks is to use the Add Bookmark command under the Bookmarks menu:

After doing this, an entry for the current page will appear under the Bookmark menu.
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When you accumulate a large number of bookmarks, you
can organize your bookmarks in the Bookmark window. To
go to the Bookmark window, select the Bookmarks item
from the Communicator menu.

A window much like this one should appear. You can see that
there are icons for bookmarks and folders.

The order of the listings in the Bookmarks menu will correspond
to the order of the items in the Bookmarks window, so you should
re-order the items here to suit your preferences.

You can insert three kinds of items into the Bookmarks window. They are available under the File menu:
New Bookmark... will allow you to insert a URL for a page you

haven’t visited in this browser yet.
New Folder... will allow you to create a new folder in the

Bookmarks window. This will create a corresponding sub-menu
in the Bookmarks menu for any items you put in the folder. You
can place folders within folders to create further sub-menus.

New Separator will place a dividing line between bookmark
items. This is helpful if you bookmark menu is very long.

To remove items in the Bookmarks window, select them with the mouse and press delete on the
keyboard. You can undelete something you just deleted with the Undo command under the Edit menu.

To move bookmark items around, simply click on their icons and drag them to the desired location. You
can make bookmark shortcuts on the Macintosh desktop by dragging a bookmark’s icon to the desktop.
You can then double-click the icon on the desktop to launch Navigator and load the corresponding page.

To edit the properties of an item, select it. Then go to the Get Info command under the Edit menu. The
window much like the one below should appear. You can change the name of the item as it appears on
the Bookmarks menu, as well as its description. For bookmarks, you can change the URL.
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USING NETSCAPE NAVIGATOR: Search Engines & Web Indices

AltaVista’s search engine, at http://www.altavista.com

The massive number of sites and documents on the Internet has made it almost impossible to locate
relevant information without the aid of a search engine. A search engine runs on a web site which holds
text downloaded from all pages known to it. Most sites running search engines allow people to submit
URLs which it will then attempt to download. Bad URLs are dropped from its archives. Periodically,
the search engine will send a ‘spider’ or ‘crawler’ out to check on the status of pages, downloading fresh
copies, or checking whether or not the page or server is unavailable. When a user submits a search
query, the search engine looks through the archives to for the terms requested, and returns the results to
the user.

You can load a search engine by typing in the URL for its site into the Location field, or by clicking on
the Search button on the Navigation toolbar to access Netscape’s compilation of Internet search
engines. However, you may eventually find that one search engine returns better results for you than the
others, and prefer simply to bookmark it and always use it instead.

Using a search engine is relatively simple. Type the relevant terms into the appropriate text field, and
click a button to submit the search criteria. It’s usually a good idea to take advantage of a Search
Engine’s ‘Advanced’ search capabilities, so look for that option if you keep getting unsatisfactory
results. Just like library catalog searches, use less search terms if you get few results, and more if you
get too many results.

A web index is similar to a search engine but goes one step further by storing the pages it archives by
topic, so that users can choose to search its pages or categories, or simply browse through the categories
to find what they need. Yahoo!, at http://www.yahoo.com, is one search engine which does this.
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TIPS & MORE HELP

On-Line Help
A great deal of information about Netscape is
available under the Help menu. From Product
Release Notes to Net Etiquette, the Help menu
should be of much assistance in your experience on
the Internet.

Web Sites
http://home.netscape.com/
As mentioned before this is the corporate site for Netscape. It should be a useful source for the latest
information on Netscape and its products. You should also check in occasionally to see if new versions
have been released that fix bugs or patch security holes.

UC Berkeley Support
http://mac.berkeley.edu/
Berkeley’s Macintosh support site. Contains older versions of Netscape Navigator and related
documentation files.
http://cab.berkeley.edu/
Berkeley’s Networking support site. Contains info and software concerning Internet connections from
home. A good place to get started if you would like to set up your home computer to connect to the
Berkeley network so that you can use Netscape Communicator and other Internet applications on your
home computer.

Manuals
Retail versions of Netscape Communicator are still available in some software stores, which will come
with full manuals and documentation. You may consider purchasing these if you need thorough
documentation on all of Communicator’s components. The Workstation & Microcomputer Facilities
generally do not have Netscape manuals available for reference.


